
Qualified Voter File Reference Manual Ch. 6 
Michigan Bureau of Elections 

Updated 1.3.2017 

Page 1 of 18 
 

CHAPTER 6 – ABSENTEE VOTER MODULES 

 

Mass AV Module ............................................................................................................ 2 

Mass Production of Permanent AV Applications ............................................................... 2 

Processing Absentee Voters Individually ................................................................... 4 

Method 1 – AV Scan .............................................................................................................. 4 

Processing Absentee Voters Individually............................................................................................... 4 

To Send an Absentee Application ......................................................................................................... 5 

To Receive an Application and Send a Ballot ....................................................................................... 6 

To Receive Ballots ................................................................................................................................. 8 

Auto OK Box .......................................................................................................................................... 8 

To Send Ballots to UOCAVA Voters ...................................................................................................... 9 

Method 2 – Voter Search/Manual AV ..................................................................................10 

Manually Track Absentee Applications & Ballots ................................................................................ 10 

To Send an Absentee Application ....................................................................................................... 10 

To Receive an Application ................................................................................................................... 11 

To Send a Ballot .................................................................................................................................. 12 

To Receive Ballots ............................................................................................................................... 14 

Edit Functions ............................................................................................................. 15 

 

 
 

 

 

 

  



Qualified Voter File Reference Manual Ch. 6 
Michigan Bureau of Elections 

Updated 1.3.2017 

Page 2 of 18 
 

MASS AV MODULE 

MASS PRODUCTION OF PERMANENT AV APPLICATIONS 

The QVF software gives you the ability to efficiently print and record AV applications for those registered 

voters who request to be on the Perm AV list, and be sent an absentee ballot application automatically for 

every election. 

 

*Dual Apps: To print dual applications for a Primary and the 

corresponding General Election, select the Primary from the Main 

Election drop-down, and the General Election will automatically 

display in the Secondary/General drop-down.  If you do not want to 

mail dual applications, simply select (NONE) from the 

Secondary/General drop-down menu. 

1. Click File 

2. Click Mass AV Applications 

 

3. Select your jurisdiction from the 2 drop-down menus in the Region Selector 

 

4. Select the current election from the Main Election drop-down menu*  

 

5. Select a precinct type from the drop down menu and then select the specific precincts. (For instructions 

on how to combine precincts or assign a ballot style alias using QVF’s Global Geography module, see 

QVF Reference Manual Chapter 3.) 

 

6. Select a Precinct Label to appear on the application  

 

7. Click the Next Step button 

  

  

http://michigan.gov/documents/sos/Chapter_3_Election_Administration_Module_192465_7.pdf
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8. From the resulting list of Perm AV voters, 

select the type of application you would like to 

print from the Output Format drop-down menu. 

 

 

 

 

 

9. Select the voters from the list that you would like to record an application for. Click the Select All button 

at the bottom of the screen to highlight/select all voters in the list. 

 

10. Click Preview then click the appropriate icon in the upper left corner of the preview screen to print or 

save a .pdf file. Then close the preview screen. 

 

 

11. Click Save to record Mass AV Application Sent Date 

 

12. Enter the Application Sent Date  

 Note: The Application Sent Date cannot be more than 14 days before or after the current date. 

 

13. Click OK and a floppy-disc icon will 

appear in the far-left column for each 

selected voter. 

 

 

 

 

 

 

 

 

IF…a voter is ineligible to receive an application / a dual application their name will appear with this red 

icon: 

 

 

 

If you try to save an application for an ineligible voter the following message will appear: 
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PROCESSING ABSENTEE VOTERS INDIVIDUALLY 

METHOD 1 – AV SCAN 

PROCESSING ABSENTEE VOTERS INDIVIDUALLY 

There are two ways to process absentee voters:  

 If you have several voters to process, we recommend using Method 1 (AV Scan). Opening the 

AV Module in this manner will allow you to process several voters most efficiently. 

Or… 

 If you have a walk-in absent voter, or have already recorded a voter’s absentee information for an 

upcoming election and need to edit it in any way: e.g. correct dates, spoil, mark invalid, or record 

the receipt of a Federal Write-in Absentee Ballot; we recommend using Method 2.  

Method 1: Click the File menu then select AV Scan. This will 

take you to the absentee module’s voter search screen.     

Method 2: Click the File menu, select one of the Voter Search options, 

search for a voter, then from their record, click the AV button at the 

bottom of the screen. Instructions for this method begin on page 10.  

Once the AV Scan Module is open, you must make the following 

selections in order to begin recording information: 

1. Select the current election from the Main Election drop-down 

menu. For dual applications, select the coordinating General 

Election from the Secondary/General drop-down menu.  

2. Add a check mark next to the action(s) you wish to perform. For 

instance, if you wish to Receive Applications and Send Ballots, 

check those 2 boxes.  If you wish to only Receive Ballots, check 

that box alone.  

3. If you type the name in the Search Term field, a list of names will 

appear that meet the search criteria. Select the name and click 

the Process button or touch the enter key.  If you scan a barcode, 

the AV Transaction screen will appear. You can also click the 

Process button. 

 

Note: When processing AVs in the AV Scan module, your actions will be recorded in the 

Activity Log (right side of the screen) to help you keep track of what has been done each 

time you open the AV Scan module.   
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TO SEND AN ABSENTEE APPLICATION  
Mailing Address:  

a) The residential address on 

record will automatically print 

on a label, unless the voter has 

previously provided a different 

mailing address, which is 

indicated with a “Y” in the MA 

column.  

b) When the residential address 

is used, a check mark will 

appear on the Res. button. If 

the voter has a mailing address, 

the check mark will default to 

the Mail button. You can 

choose which address will print by clicking on the button. You can also record a different address by 

clicking the clear button and entering a different address. 

4. Enter the date the application was 

sent.  This field defaults to the current 

date. To change the date, just delete 

the values in the field and type your 

own date.  Then, select the type of 

application you would like to print from 

the Format drop-down menu. 

 

5.  If you want to print the application 

right away, add a checkmark to the 

appropriate box listed under Options. 

To customize the precinct label, you 

can choose to have you can choose 

to print the precinct number, 

combined precinct number, or ballot 

style. Otherwise, click the OK button 

and the application will be sent to your 

Print Queue to print later. If you are 

recording the application but do not 

wish to print it out of the QVF 

program, you can either delete the 

print job or leave it in the Print Queue 

for 30 days and it will be automatically deleted. 
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TO RECEIVE AN APPLICATION AND SEND A BALLOT 
 

Repeat Steps 1-3 pg. 4, selecting Receive Apps & Send Ballots 

 

4. Receiving Application(s) 

a. Enter the date the application was received.  This field defaults to the current date. To change the 

date, just delete the values in the field and type your own date. 

 

b. If you are recording the receipt of a Federal Post Card Application, add a check mark to the 

FPCA box. (For further instruction on how to process FPCA applications please refer to our 

Military and Overseas Voters Manual.) 

 

5. Sending a Ballot 
 

a. Enter the date the 

ballot was sent. 

Remember, unless 

you change the 

date, the default will 

be the current date. 
 

b. Enter the Ballot 

Number in the Ballot 

Number field.  If you 

are processing a 

group/stack of 

applications and do 

not want to 

manually enter the 

ballot number for 

each voter, add a 

checkmark to the 

Auto-Advance Ballot 

Number option (see 

[d] on page 7).         

 

Note: if you are sending a .pdf ballot by email, fax, or postal mail to a military or overseas 

voter, type the letters “ET” before the ballot number, e.g. ET00001.  

 

c. Set your Lockout: The Lockout option will allow QVF to accommodate duplicate 

ballot numbers, depending on the way the ballots were numbered when ordered. 

i. None: allows you to duplicate a ballot number at any time 

ii. Election: allows you to issue a ballot number only once per election 

iii. Precinct: allows you to issue a ballot number only once per precinct 

iv. Counting Board: allows you to issue a ballot number only once per 

Counting Board 

1. If using this option, you will need to first create an Absentee 

Counting Board using the Global Geography module.  

v. Ballot Style: allows you to issue a ballot number only once per ballot style. This is 

usually your best option.  

http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
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d. Select Options: 

 

 

 

 

 

6. Ballot Address & Delivery Method 

 

  

 Mailing Address: If the address the ballot will be sent to is different from either the residential or 

mailing address on record, you can click the Clear button and record a different address which 

can then be printed on a label if you wish.  

 UOCAVA Status & Delivery Method: Since most voters do not qualify for UOCAVA status, Non-

UOCAVA is the default selection. For these voters, you may only select either Postal Mail or In 

Person as the delivery method. 

o If you are processing an application from a military or overseas voter, select the 

appropriate UOCAVA status (Military, Overseas Civilian) and delivery method for the 

voter. These voters’ ballots can be delivered by any one of the Delivery Method options 

(In Person, Postal Mail, Fax, Email). For further instruction on how to process these 

voters, refer to our Military and Overseas Voters Manual. 

 

7. Click the OK button  

 

http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
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TO RECEIVE BALLOTS 
 

Repeat Steps 1-3 pg. 4, selecting Receive Ballots 

 

4. Enter the date the 

application was received.  

This field defaults to the 

current date. To change the 

date, just delete the values 

in the field and type your 

own date. 

 

5.  Click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AUTO OK BOX:  If you wish to quickly receive a large number of ballots, check the “Auto OK” and the 

“Receive Ballots” boxes and begin scanning your ballots.  The AV Transaction screen will appear for ½ 

second and then disappear unless there is a problem 

(e.g.-ballot has already been received), allowing you to 

quickly receive the next voter’s AV envelope. 

 

 

Note: If a ballot is returned by the U.S. Postal Service as “undeliverable”, you can search for the voter in 

the AV module, add a check-mark to “Mark Ballots Undeliverable”. Then, click the Process button (or 

touch the Enter key). 

 

 

In the next window, 

confirm the ballot number 

and click OK. 
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TO SEND BALLOTS TO UOCAVA VOTERS 
 

Add a checkmark to the UOCAVA Scan Mode option to automatically pull up voters flagged as Military or 

Overseas Civilians and easily process their ballots before the MOVE ballot deadline (45 days prior to 

every election in which the voter is eligible to vote in).  
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METHOD 2 – VOTER SEARCH/MANUAL AV 

MANUALLY TRACK ABSENTEE APPLICATIONS & BALLOTS 
Method 2 

If your preference is to perform a voter search and click the AV button at the bottom of the voter’s record 

in order to open the AV module, doing so 

will take you to the AV screen shown below. 

 

1. Voter Search 

2. Click the AV button (located in the lower 

right corner of the voter’s record). 

3. If current election date is not selected, 

choose from the Main Election drop-down 

menu. (If the main election is a 

primary and you are using 

dual applications, select the 

corresponding General 

Election from the 

Secondary/General Election 

drop-down menu. If you are 

not sending dual apps, select 

NONE.)  Select your printing 

options. 

TO SEND AN ABSENTEE 

APPLICATION 
4. Click the Send button on 

the Application section of the 

Absentee Voting window.  

5. Enter the date the 

application was sent.  This 

field defaults to the current 

date. To change the date, 

just delete the values in the 

field and type your own date.  

Then, select the type of 

application you would like to 

print from the Format drop-down menu.  

 

6. To save the information and send the application to the Print Queue to print later, click OK. To print 

right away, add a checkmark to the appropriate box listed under Options before clicking OK.  

Note: Choose an option from the Precinct Label drop-down menu to designate a Precinct Label to include 

on the application.  

**Address Information: The address that will print on the application or label will be the residential 

address on record, unless the voter has previously provided a different mailing address. When the 
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residential address is used, a check mark will appear on that button. If the voter has a mailing address, 

the check mark will default to the Mail button.  You can choose which address will print by clicking on the 

button. You can also record a different address by clicking the Clear button and entering a different 

address. 

TO RECEIVE AN APPLICATION  
 

Repeat steps 1-3, pg. 10        

 

4. Click Receive under Applications 

 

5. Receiving Application(s) 

a. Enter the date the application 

was received.  This field 

defaults to the current date. 

To change the date, delete 

the values in the field and 

type your own date. 

b. If you are recording 

the receipt of a 

Federal Post Card 

Application, add a 

check mark to the 

FPCA box. (For 

further instruction 

on how to process 

FPCA applications 

please refer to our 

Military and 

Overseas Voters 

Manual.) 

 

6. Click OK 

 

 

 

 

  

http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
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TO SEND A BALLOT 
 

Repeat steps 1-3, pg. 10 

 

 

4. Click Send under 

Ballots 

 

Note: Select Print 

Options before 

recording the ballot 

 

 

 

 

 

5. Sending Ballot  

   

a. Enter the date the ballot was sent. Remember, unless you change the date, the default will be the 

current date. 
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b. Enter the Ballot Number in the Ballot Number field.  If you are processing a group/stack of 

applications and do not want to manually enter the ballot number for each voter, add a checkmark 

to the Auto-Advance Ballot Number option (see [d] on page 13). The Auto-Advance advances 

from the last number used and does not advance by ballot style. 

 

Note: if you are sending a .pdf ballot by email, fax, or postal mail to a military 

or overseas voter, type the letters “ET” before the ballot number, e.g. ET00001.  

 

c. Set your Lockout: The Lockout option will allow QVF to accommodate duplicate ballot numbers, 

depending on the way the ballots were numbered when printed. 

i. None: allows you to duplicate a ballot number at any time 

ii. Election: allows you to issue a ballot number only once per election 

iii. Precinct: allows you to issue a ballot number only once per precinct 

iv. Counting Board: allows you to issue a ballot number only once per 

Counting Board. 

1. If using this option, you will need to first create an Absentee 

Counting Board using the Global Geography module.  

v. Ballot Style: allows you to issue a ballot number only once per ballot style 

 

d. Select Options: 

 

 

 

 

6. Ballot Address & Delivery Method  
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 Mailing Address: If the address the ballot will be sent to is different from either the residential or 

mailing address on record, you can click the Clear button and record a different address which 

can then be printed on a label if you wish.  

 UOCAVA Status & Delivery Method: Since most voters do not qualify for UOCAVA status, Non-

UOCAVA is the default selection. For these voters, you may only select either Postal Mail or In 

Person as the delivery method. 

o If you are processing an application from a military or overseas voter, select the 

appropriate UOCAVA status (Military, Overseas Civilian) and delivery method for the 

voter. These voters can request any one of the Delivery Method options (In Person, 

Postal Mail, Fax, Email). Further instruction for processing these voters can be found in 

our Military and Overseas Voters Manual. 

 

7. Click the OK button. 

  

TO RECEIVE BALLOTS 
 

Repeat steps 1-3, pg. 10 

 

4. Click Receive under 

Ballots 

 

Note: If a ballot is returned 

by the U.S. Postal Service 

as “undeliverable”, you 

should click the “Undel.” 

button to document the 

failed delivery, instead of 

clicking the Receive button. 

 

5. Receiving Ballots: Enter 

the date the ballot was 

received.   

This field 

defaults to 

the current 

date. To 

change 

the date, 

just delete 

the values 

in the field 

and type 

your own 

date. 

 

6.  Click OK   

http://www.michigan.gov/documents/sos/Military_overseas_manual_396041_7.pdf?20150716104901
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EDIT FUNCTIONS 

 
 

If you have already recorded a voter’s absentee information for an upcoming election and need to edit it 

in any way: e.g. correct dates, spoil, mark invalid, or record the receipt of a Federal Write-in Absentee 

Ballot; you can click the Manual AV button from the AV Scan screen, or you can perform a voter search 

then click on the AV button on the individual’s record. 
 

a. Edit Application: Allows you to 

change the status, date, or 

address of an application. 

 

 

 

 

 

 

 

b. Delete Application: Deletes, or undoes, the issuance of 

an application. 
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c. Print Application: Gives you 

options for what kind of 

application to print, when to 

print, and the ability to 

preview the application. 

 

 

 

 

 

d. FPCA: Use this button to record the 

receipt of a Federal Post Card Application 

from a military or overseas voter. 

 

 

 

 

e. Precinct Label: Designate which precinct type category 

to include on absent voter applications or absentee 

ballot labels. It may be helpful to select “Ballot Style” 

from this menu to identify different ballot styles within 

split precincts.  

 

 

 

f. Edit Ballot: From this 

screen you can spoil, 

reject, change the 

reason for rejection, 

change the status of a 

ballot or mark it as 

“undeliverable”.  You 

can also change the 

UOCAVA status, 

delivery method, and 

address the ballot will 

be sent to.  

 

g. Delete Ballot: Deletes, or undoes, the issuance of a ballot.  
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h. Print Label: Prints a label for you to use when sending the ballot. The label will automatically go to 

your Print Queue to print later unless you enable the option to “Print Labels Now”. 

 

i. FWAB: You may receive a 

Federal Write-In Ballot from a 

military or overseas voter for you 

to count in the event that the 

ballot the clerk already sent is not 

returned in time.  (If you receive 

an FWAB ballot, you must record 

the receipt of the FWAB as it will 

act as a place-holder for the clerk-

issued ballot.) 

 

 

 

 

 

 

Once you have received an FWAB in QVF, you will notice changes in the status of the ballot, shown 

below:   

 

 

 

 

j. Spoil: To be used if a voter requests a new ballot 
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k. Reject: To be used under the rare circumstance that an AV ballot will not be sent to the polls on 

Election Day. 

 

When rejecting an absentee ballot you must select a reason for the rejection: 

 No signature by Election Day 

 Signature does not match by Election Day 

 Ballot returned after 8 PM by Election Day 

 Voter sentenced to serve jail time by Election Day 

 Voter moved and eligible to vote in new jurisdiction 

 Voter died before Election Day 

 

 

 

 

 

 

 

 

 

 

 

 

l. Undeliverable: If a ballot is returned by the U.S. Postal Service as “undeliverable”, you can record 

that in QVF by click the Undel. button. 

 


